Comprendre l'integration des points d'acces via
Catalyst Center Plug and Play
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Introduction

Ce document décrit Cisco PnP pour l'intégration de points d'accés sans intervention avec Catalyst
Center.

Description

Les services Plug-and-Play (PnP) sur Catalyst Center offrent un processus de déploiement
automatisé et automatique qui simplifie le provisionnement des points d'accés et la configuration
des sites. Ce guide décrit les étapes détaillées d'intégration de nouveaux points d'acces dans
divers scénarios de déploiement en temps réel, y compris les approches basées sur l'intention et
non basées sur l'intention. En outre, il fournit des conseils de dépannage complets pour garantir
une expérience de déploiement fluide et efficace.



Exigences

Connaissance de ces sujets :
» Contréleurs sans fil Cisco Catalyst 9800
+ Points d'accés Cisco
» Automatisation et provisionnement sans fil de Catalyst Center
» Déploiements de Catalyst Center Assurance

+ Configuration par périphérique (PDC) de Catalyst Center / Automatisation du campus

Conditions préalables

» Cisco Catalyst Center version 2.3.7.9 ou ultérieure.

» Contréleur sans fil Cisco Catalyst 9800
» Option 43 configurée sur la configuration du serveur DHCP du point d'accés avec l'adresse
IP de l'interface d'entreprise de Catalyst Center. Reportez-vous a I'exemple de I'étape 1.

Etape 1 : Option 43 configurée sur le serveur DHCP du point d'accés Config avec I'adresse IP de
l'interface d'entreprise de Catalyst Center

L'IP d'entreprise de Catalyst Center doit étre I'IP de I'option 43 puisque nous utilisons l'intégration
a partir de Catalyst Center, voici deux exemples :

+ Exemple d'adresse IPv4 pour entreprise de Catalyst Center : 9.7.144.14

ip dhcp pool VLAN137
network 9.7.137.0 255.255.255.0
default-router 9.7.137.1
option 43 ascii 5AIN;B2;K4;19.7.144.14;380



» Exemple d'adresse IPv6 pour entreprise de Catalyst Center : 2001:60:60:60::133

ipv6e dhcp pool AP_PNP
address prefix 2001:70:70:70::/64
Tink-address 2001:70:70:70::7/64
vendor-specific 9
suboption 16 ascii "ciscopnp"
suboption 17 ascii "5A1D;B3;K4;I2001:60:60:60::133;380"

* Exemple de DNS pour I'adresse IP d'entreprise de Catalyst Center

ip dhcp pool v1an200
network 10.200.0.0 255.255.0.0
default-router 10.200.0.1
domain-name pnpagent.test.com
dns-server 8.8.8.8

* Les points d'accés doivent étre préts a I'emploi ou en mode de réinitialisation d'usine pour
que l'agent Plug and Play démarre sur le point d'acces.

» La connectivité réseau doit exister entre les points d'accés, Catalyst Center et le contréleur
sans fil.
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Etape 2: Ajout d'AP au serveur Plug and Play :

L'utilisateur peut accéder aPage Plug and Play du menu principal > Provisionnement > Network-
Devices > Plug and Play.

Il existe deux fagons d'ajouter de nouveaux périphériques a la page PnP pour l'intégration

2.1 Points d'accés préajoutés par I'utilisateur : Ajout d'un seul périphérique ou téléchargement
CSV en masse. Les utilisateurs peuvent préajouter des périphériques en utilisant le numéro de
série, le PID et le nom du point d'acceés pour préréclamer le point d'acces. Lorsque le point
d'acces se connecte et contacte le serveur Plug and Play, la configuration automatique du Plug
and Play est envoyée au point d'acces a partir de Catalyst Center.

Ajout d'un seul périphérique :
Ajouter des périphériques->Ajouter un périphérique unique :
Add a Single Device

Serial Number®

12345

Product ID*

Davice Mame
F -

Tasf

Ajout de périphériques en masse via CSV :



Add Devices in Bulk !

Choose a file or drag and drop to upload

m +, Downland Fillo Template

2.2 Les points d'acces se connectent via le réseau : Points d'acceés qui ne sont pas préajoutés au
PnP. Une fois que le point d'accés est connecté a un commutateur et mis sous tension avec les
parameétres d'usine par défaut, le point d'accés contacte le serveur Plug-and-Play sur Catalyst
Center, apparait sur la page Provisionner -> Plug-and-Play et est prét a réclamer.

Il existe deux exemples d'utilisation de déploiement pour l'intégration d'un nouveau point d'acces
en fonction du déploiement réseau que vous avez configuré sur Catalyst Center .

1. Déploiement réseau basé sur les intentions - Accédez a l'intégration AP avec affectation de
site Exemple d'utilisation (déploiement réseau basé sur les intentions).

2. Déploiement de réseaux sans intention - Accédez a l'intégration de points d'acces sans
exemple d'utilisation d'affectation de site (déploiements de réseaux sans intention tels que
I'assurance et la configuration par périphérique).

Intégration du point d'acces avec affectation de site Cas
d'utilisation (déploiement réseau basé sur l'intention)

Cet exemple d'utilisation convient aux clients dont le réseau sans fil a été congu et configuré a
partir de Catalyst Center a I'aide de I'automatisation basée sur l'intention et du 9800-WLC avec
des emplacements gérés.

S

Remarque : Si vous souhaitez configurer I'emplacement AP de la méme maniére que
I'emplacement du site, activez la case a cocher AP PnP location sous System > Settings >
PnP AP Location - Redirection details show on page.

1: La page Plug-and-Play est disponible dans Provisionnement->Plug-and-Play :Sélectionnez un
ou plusieurs points d’acces a réclamer



and Play
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Page PnP Overview (Demande/Modifier/Réinitialiser/Supprimer/Autoriser)

2 Attribuez le point d'accés a I'étage ou vous souhaitez le réclamer

Assign Site to APC414.A2FB.0CBO

: Select a site - floor or cutdoor area managed by Wireless
Assign Site

Design » Controller(s).
1] Policy » Assign Site

Provision » & Two (2) Warning Algrts and On (1) Information Alert on this page. Expand to see details
5 Assurance »

Devices (1)

sts Workilows

% Emergy Management

A Tools » Devics Mame Serial Number Product I Site (Recommended) edisil
Ll - A PErPRp——— WNT 28200066 cwenTel Assign
& Activities »
Reports
3 system »
o Explote

Affecter a un site

3 Attribution du profil RF pour AP



“Hu  Catalyst Center

Configuration for device name: APC414.A2FB.0CBO

Ausign
v) Assign Site .
Design » G Configuration Serial Humber  WNTI8200060
" . H Product ID
) Policy > Assign Configuration

Assighad Site af- Jaie/BGLIFLAY

2 Provisien » AP Los will be configured as the sssigned site as part of the provision during the claim process. Toc  Device Mame  APCA14 AZFB.OCEO
updated, click Refresh &
Aw
. RADIO FREGUENCY PROFILE
= Weorkfiows Davices (1)
4 Energy Managemaont
X Tools » Ql
Device Name Sarial Number Praduct ID Assigned Site
5 Platform »
b APCA14AZFB.OCED WHTIEZ000E6G CwaiTEl Global/San- Josell
1 J Y X ..
Report
System »
Expio

Attribuer un profil RF

4 si l'utilisateur n'a pas activé l'indicateur d'emplacement AP PnP dans le paramétre systéme et
que vous souhaitez configurer I'emplacement AP de la méme maniére que lI'emplacement du site,
activez la case a cocher AP PnP location sous System -> Settings -> PnP AP Location -
Redirection details show on page [one time enable]

Aprés la configuration, revenez a la méme page d'affectation RF et actualisez. S'il est activé, i
s'affiche en vert, s'il n'est pas activé, il s'affiche en orange.

et Catalyst Center System | Settings

Settings Device Settings

S ’ Certificates “ PnP AP Location
t] Policy ¥ System Certificates By selecting the below checkbox, Access Paint's assigr as
AP Lo is applicable only d
Trusted Certificates
*_ Provision »
Certificate Authority
Assurance 3 . . Configure AP Location
o uranee Device Certificates
ses Workflows Cisco Accounts W
PnP Connect
7

& Energy Management
Cisco.com Credentials

A Tools »

Smart Account

= Platform 3 Smart Licensing
55M Connection Mode
2 Activities »
Device Settings W
[*] Reports
d gl Image Distribution Servers
&1 system > PnP Device Authorization

Emplacement du point d'accés PnP



Emplacement du point d'acces activé : L'emplacement du point d'accés est configuré en tant que
site attribué dans le cadre de la mise a disposition pendant le processus de demande.

Network Devices [ Plug and Play

@ Assign Site

Desig
Policy » Assign Configuration
2 Provision » @ AP Location will be configured a3 the 54igned site a3 part of the provision during the clsim process. To changs Ihis setting, go to System -> Settings -» PP AP Location CF . After the setting i
updated, click Refrosh =
o Assurance »

$s Workflows Davices (1) Clear Configuration ~
@y Energy Management
A Tools »

Davica Nama Sarial Numbar Product ID Assigned Site Configuration Actions
& Platform
T APCA14 AZFBOCED WNT2820006G CWa178 GlobalfSan-Jose/BGLIFLRY RF Profile: HIGH
] Activities ¥
Reports

Emplacement du point d'accés activé

5 Passez a la page suivante Modéle de mise en service sans action requise et passez a la page
suivante. Vérifiez I'apergu de la configuration et la demande.

el Catalyst Center Netw: 25 [ Plug and Play
Configuration summary %
- PTE— oy Assign
Day-0 Configuration Preview
i) Peliey y Summary
primaryWicip 2.7144.62
_._ Provision
Devices (1) primaryWichame WLC-176-JAGY
5 Assurance > policyTaghame PT_San-J BGLIFLR1GSIS
RF TagName HMIGH
Workilow
sitoTagNamo ST_San-J_BOL_474¢c 0
Dewice Nams Sorial Humbar Produet 1D Assigned £
En
)
¥ ACIMAPRECR Wi 00080 NoT e
A Tocis ; PCA1SAZFB.OCED WNTZ8200080 CWEITH! Global/San .
= Platform > Daviea Hama
Serial Numbes
-~
Product iD
Ruparts Davice Type AP
Site GlobaliSan -Jose/BGLIFLRY
Syt
Exp
Radio Frequancy P
Radio Frequency HIGH
Profile

Récapitulatif de configuration AP

6 Une fois que le point d'accés est revendiqué, la configuration est poussée vers le point d'accés
et elle se joint a un contrdleur particulier gérant le site et apparait dans l'inventaire Catalyst Center
avec la mise a jour snmp-trap et est automatiquement provisionnée avec les balises AP et
I'emplacement du point d'acces

Journaux de console AP :



[*09/15/2025 07:
[*09/15/2025 07:
[*09/15/2025 07:
[*09/15/2025 07:
[*09/15/2025 07:

14
14
14
14
14

:36.
:36.
:36.
:36.
:36.

show ap tag summary

APC414.A2FB.0CBO

5440] PNP CONFIG -
5440] PNP CONFIG -
5440] PNP CONFIG -
54427 PNP CONFIG -
54427 PNP CONFIG -

c414.a2fb.0cb0

PRI WLC IP :
PRI WLC NAME:
Policy Tag :

Site Tag
RF Tag

9.7.144.62

ST_SanJ]_BGL1_474cc_0

eWLC-176-JAGU
PT_San-J_BGL1_FLR1_65f15
:ST_San-J_BGL1_474cc_0

: HIGH

PT_San-J_BGL1_FLR1_65f15

7 Une fois que le point d'accés est ajouté a l'inventaire avec le déroutement SNMP, le point
d'acces est marqué comme provisionné et la page Plug and Play et le provisionnement

automatique du point d'accés est effectué

I Catalyst Center

atbiailie
cisca

. Provision »
i: Workflows

4 Energy Management

A Tools »

Etat d'intégration AP

Network Plug and Play Overview

Device Status

0 Sebected

Al Unclaimed (%)

Devices (7) 8| AN v

Actions ~

DBavice Namae

- APBCEEB1E2 FAED

o WLE-PHP

- APCCOC.IEF1OCBO

o APFECE 5009.7778

* APICEZ BETLFS7C

r APBCBE.BIFA.BZAD

- APCA14.AZFB.OCH0

Sarlal Number

FVHIDOZACID

FCL2B520138

KWC2B0801YE

FICZRI0I4PE

FYTZE15LITM

FICZMNTIPR

Product I Last
CWONT4I Sap 1
COBDO-L-C-KD Sep

CWoIEA-B Sep 15,

Co1361-ROW Sep 15,

CONSAXE-D Sep 15, 20

CWENGIE-ROW Sep 15,

Contact State
11, 2025 5:00:01 PM
09, 2025 1:49:47 PM

2028 12:40:15 P

025 124813 P

0325 12:48:46 PM

2025 12:49:08 PM

2025 12:47:35 PM

148.76 LT

187.2 CC:oC:IEF1 00
157 .4 FRICH:50:09:77
1 E3:BE:T1:F
157 BGC:BBI81 F4:82
157,28 c AZ:FB

8 Une fois le point d'acces ajouté a l'inventaire, la mise en service automatique déclenche et met
en service les balises du point d'acces et fait passer le point d'acces a I'état de mise en service



ulle Catalyst Center Provision / Inventory

= g San-Jose o Roters  Switches  WirskssControlers  AccessPolts  Semsons ol = | Be _'

Design » i Eotus -
9 DEVICE WORK ITEMS Devices(3) Focu Provisien v

. a L~ ~
Y Polley 2 () Unreachadle = = APCH4.AZFB.0CBO
®  Provision » b OSelected Tag + Adddevice  Actions 7 View Device Details [ View 360

Untagged P Address 3415728
g Assurance ¥ Tags Device Name *
o ed Provis

Family

#s Workflows Non Compliant

APCA14 AZFB.OCED Mgt Verson
Site
Energy Management

Provision $tabes

APCAdBBBTIISI0 | o e ks

X Tools »
Externet MAC Address
5 Platform ¥ eWLE-176-JAGU.dns.
D Activities »

5 Reparts (] Marked for Retresh D
{

Afficher les détails AP

Health WA

Takeatour & Export &

Asof: Sep 15, 2025 1250 M 2

Uptime 17 mins
Reachability Provisioning Status c

R © Beachable SJ::.E;;

Rl © Reachable S ers

ef8GL1 @ Reachable $ :_-N.;

Show More

L'emplacement est défini sur le point d'accés en fonction de I'affectation de site. Exécutez show ap

summary sur WLC CLI :

show ap summary
APC414.A2FB.0CBO 4 Cw91781

c414.a2fb.0cb0 ecf4.0c9d.1260 US

Cas d'utilisation de l'intégration du point d'accés sans affectation
de site(déploiements de réseau non intentionnels comme
I'assurance, la configuration par périphérique)

Création d'un modeéle 1 jour zéro dans Catalyst Center

1.1 Accédez a Catalyst Center Tools > Template Hub.

-B

9.4



el Catalyst Center

Template Hub _ _ |
grated platform, we are changing the name of Cisco DNA Center to C

NA Center.

Critical Issues

View Details

Concentrateur de modeles

1.2: Dans la section Modeéle, sélectionnez Nouveau projet > Configuration de l'intégration >
Ajouter > Sélectionnez un nouveau modele et créez-le comme indiqué, puis continuez.

Templates (3)
= Filtered B ¥
= ! Add New Template
- Onboarding Configerati_
) b ’ Template Details
] Policy ¥ :
Summary 0 Selected & Import v Template Hama*
*  provision 3 + Project Name (3 X AP-PrP-Dayl-Template
Name * Project Type Version % S
Ontoarding Configuration
g Assurance ¥ Project Name*

Sample Jinja Templates (] J AR-prP-Cliim  Onboarding Configuration Regular 1

w41 Workflows Sample Velocity Templates

] 3 apeap Onboarding Configuration  Reguiar 1 Template Type
> 3 Tyne (1
), Energy Management + Type O Bacilar Tamolat ,
®) Regular Te 1 G
» Template Language (2 J KK Onboarding Canfiguratior feguiar Mot Committed §
’\ Tools ¥ Deployment Type
» Category (2 ) Day N @ Diay 0
gl ’ £ Template Language
» Deviee Fasmily (! 9 9
® mua ) vewociTy
2 A ¥ vich Sarie 1
Activities ¥ 3 Device Series Eofveaii T
Reporis ommit State (2

* Provigion Status (1
1 System ] Device Type Details
> Potential Design Conflicts (1 Add the types of devic

7| Explore
Device Details®  Edit Davice Detslts

Device Family

Devices

* Additional Details

Nouveau modele



Nouvelles entrées de modéle.

» Saisissez les informations suivantes :

* Nom du modéle :** Entrez un nom pour le modele

* Nom du projet : ** Configuration d'intégration

* Type de déploiement : ** Day0

* Langue du modéle : ** Jinja

» Type de logiciel:** Cisco I0S XE

* Famille de périphériques:** Contréleur sans fil

* Modéle de périphérique :** Contréleur sans fil Cisco Catalyst 9800

Exemple de modéle AP dayO :

"primaryWIclIP" : "9.7.149.10",

"secondaryWIclIP" : "9.7.14.62",

"policyTagName" : "default-policy-tag",

"siteTagName" : "default-site-tag",

"RFTagName" : "default-rf-tag",

"primaryWlcName" : "JAGU-WLCAPWORKFLOW",

"secondaryWIcName" : "eWLC-176-JAGU"

1.3 Ajoutez les détails de configuration dans le modeéle pour pousser vers le point d'accés pendant
la revendication du point d'acces par le biais de I'enregistrement et de la validation du modeéle.



I;IIIEI:!DII Catalyst Center Design [ CLI Templates

CU Templates > J AP-PP-Day0-Template (Not Commilted) Templste Properties

Templates Variables Simulation Provision Conflicts

44 Design ¥
) System Variables Assistant = Template History () Show Design Conficts

y H

*  Provision »

g Assurance H

+= Workflows

Energy Management

*\ Tools ¥
Platform ¥

®  Activities »
Reparts

] System ¥

g Explore

- .
Discard Changes Save m

Section Modéle de conception

2 demandes de points d'accés sans affectation de site

2.1 Accédez a la page Provisionnement > Plug and Play et sélectionnez le point d'acceés et la
demande

S

Remarque : Vous pouvez sélectionner un ou plusieurs points d'acceés et leur attribuer un
modele.



nlutle Catalyst Center

Network Plug and Play Overview

Design »
1) Policy y
2 Provision 5 Device Status ..:I'-:S'J Unclaimed (2]~ @ Error(0) @ Provisioned (1)
o Assurance ’ Devices (3) Focus: | AN v 1 Auto-refresh+ 305 ~ + Add Devices @

wee Workllows

4 Energy Management

15elected  Actions ~ Asof: Sep13, 2025 5:20PM O Redresh
Y Tools » =] Claim . i
] Name Serial Numbar Product ID Last Contact State Onboarding Prograss IP Address MAC Address
L Platform > Edit
1 b HB.B152.F4ED FVH2O02AC30 cwarral Sep 1, 2025 50001 PM id Device dy 16 d 9.7.137.21 BC:B8:B1:52:F4
T Activities >
2 o Delete yp FCL2652013B COBOO-L-C-K®  Sep 09, 2025 1:48:47PM ¢ O prov j 9.7.148.7% HA
Reports Authorize
3 1 rrwrid AZFB.OCGBD  WNT28200066 CwWaiTal Sep 13, 2025 5:20:04 PM Inclalmed Device is ready to be claimed 9.4.157.28 C4:14:A2:FB:6OC
sl System H
g Explore

Revendication AP sans affectation de site

2.2 Sur la page suivante, ne sélectionnez aucune option dans la page de sélection du site et
passez a la page suivante.

o Assign Site

Design »

1) Palicy 3 Assign Site
= Provision » A T (20 Wasning Alerts and One (1) Irformation Alert on this page. Expand to see detsils

o Assurance »

Devices (1)

= Workflows

4 Energy Managoment
K Teols » Device Name Serkal Humber Predust I $lte (Recommended) Actions

5 Plat OB

) = - Prep—— WNTZ8200066 CWaNTE Assign
2 Activities »

Reports
3 System »

Showing 10f 1

Canse e

Affectation de site (laisser non sélectionné)

2.3 Dans la page de sélection du modéle, sélectionnez le modéle qui est créé.



Design
1) Policy
Provision
5 Assurance
- Waorkflows
4 Emorgy Management
A Tools
Platform
2  Activities
Reports
2l System

o Explore

- Assl
@ Assignsite sion
Contiguration

Assign Configuration
L

updated, click Refresh &

Devices (1)

Davice Name Serial Number Product 1D Assigned Site

& AZFB.0CBOD WNTZB200060 CwIn7al MA

Showing 1 of 1

(1) Sélectionner un modele

AP Location will be eonfigured as the assigned site as past of the provision during the claim process. To change this selting, go 10 System => Settings > PP AP Location O . After the setting is

Clear Configuration ~

Configuration Actions

Template: Assign”

2.4 Cliquez sur le modéle assigner et dans la liste déroulante, sélectionnez le modéle créé pour
pousser pour AP et enregistrer

Design
1] Policy
Provision
o Assurance
=32 Workflows
{74 Energy Management
A Toels

5 Platform
S Activitios

Reports
51 System

o Explore

Assign
« ) Assign Site
C 9 Configuration

Assign Configuration

AP Location will be configured as the assigned site as part of the provision during the claim process. Tc

€@ Lpdateg, chick Refrash
Daevices (1)
Davice Hamae Serial Humbar Product ID Assigned !
- APCA14AZFBOCED WNTZEZ0006G cwelran A
Showing 1611

(2) Sélectionner un modele

Configuration for device name: APC414.A2FB.0CBO

Serial Humber  WNTZ28200065
Produet ID cwarel
Assigned Site Mo Site

Device Name APCAN4AZFB.OCED

Failed 10 retrieve a device-specific template. Select from the available onboarding

Iy

templates:

AP-PrP-Day0-Temgdate

2.5 Cliquez sur Next (Suivant) et affichez un apercu de la configuration sur AP et la revendication



Design

Polley

Pravisian

o Assurance

= Workflows

@ Energy Management
A Tools
;  Platterm
T Activities
Reports
System
o Explore

©) Assignsie o
an s Configuration
Assign Configuration

AP Location will be configured as the assigned site as part of the pravision during the claim process. Te
updated, click Refresh

-]

Devices (1)

Davice Mama Sarial Humbar Produst 1D Ansigned ¥
- APCA14.AZFB.OCED WNT28Z0006G Cwol7a MA
Showing 1 of 1

(3) Sélectionnez Apercgu de la configuration du modéle

Configuration for device name: APC414.A2FB.0CBO "

Daovies Mame  APCA14.A2FB.OCED

Failed ta retrieve a device-specific template. Select from the available onboarding

a

templates
Select a Te

Copy r an to startup configurs
Template  AP-PnP-Day0-Template

Project Onboarding Conlig

Created Sep 13, 2025 5:05:3

Updated Sep 13, 2025 &

Export Copy

{

primaryNlcIP™: “9.7.149.18°,
“secondryWlcIP™: “9.7.144.62°,
policyTaghame™: “default-policy-tag”,
“siteTagheme™: “defoult-site-tag”,
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2.6 Apres la revendication, la configuration est poussée vers le point d'acces et le point d'accés
rejoint le contrdleur respectif. Il est affiché dans l'inventaire
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Aprés avoir rejoint le contréleur sans fil, le point d'accés est affiché dans l'inventaire en fonction de
ce cas d'utilisation :



» Cas d'utilisation 1 - Assurance # Nouveau point d'accés demandé au contrdleur sans fil qui
est ajouté dans Catalyst Center avec affectation de site uniquement, nouveau point d'acces
intégré apparait dans l'inventaire avec la synchronisation snmp-trap. Une fois le point
d'acces affiché, l'inventaire est prét a étre géré a partir de Catalyst Center.

» Cas d'utilisation 2 - Par périphérique # Nouveau point d'acces demandé au contréleur sans
fil qui est ajouté dans Catalyst Center sans affectation de site, le nouveau point d'acces
intégré n'est pas affiché dans l'inventaire jusqu'a la synchronisation “1°. Une fois que le point
d'acces apparait dans l'inventaire, il est prét a étre géré a partir de Catalyst Center.

Vérifiez sur le controleur sans fil :

show ap tag summary
show ap summary

 Vérifiez la page PnP apres avoir ajouté AP a l'inventaire, doit é&tre marqué comme
Provisionné.
- Pour cela, accédez a Provisionner > Périphériques réseau > Plug and Play sur
l'interface graphique utilisateur de Catalyst Center.

Dépannage de l'intégration AP

Vérifications préalables

» Assurez-vous que DHCP Option 43 ou DNS est correctement configuré afin que I'AP puisse
découvrir le serveur Plug and Play.

 Veérifiez que le point d'accés est accessible a Catalyst Center a I'aide des commandes ping,
traceroute et des vérifications de connectivité réseau de base.

« Vérifiez si I'AP apparait sur la page PnP sans aucune erreur.

» Validation des revendications PnP

» Lorsque le point d'acces est visible sur la page PnP, vérifiez les détails du périphérique
avant la demande.

» Lorsque l'utilisateur demande le point d'acces, vérifiez les détails de I'apercu.

+ Vérifiez I'état de la demande une fois celle-ci envoyée.

» Une fois la demande d'AP terminée, vérifiez que I'AP progresse correctement dans le
workflow d'intégration.

» Validation du contrdleur sans fil

+ Sur le contréleur sans fil, vérifiez I'état de jonction AP en utilisant :show ap summary



show wireless stats ap join summary

+ Sile point d'accés ne rejoint pas le contréleur, identifiez la raison de I'échec de la jonction et
recommencez l'intégration aprés avoir effectué une réinitialisation d'usine du point d'acces,
si nécessaire.

+ Sile point d'accés est revendiqué et joint au WLC électronique, et que I'état d'exécution du
workflow Plug and Play est visible, mais que le point d'accés n'est toujours pas visible dans
l'inventaire Catalyst Center, vérifiez le service d'inventaire, le traitement des interruptions et
la synchronisation d'inventaire.

Meilleures pratiques

Evitez d'exécuter des activités de mise en service sur le WLC qui est impliqué dans l'intégration
de nouveaux AP.

Les activités d'approvisionnement simultanées peuvent déclencher la synchronisation des stocks,
ce qui peut entrainer un retard de la file d'attente ou du portefeuille.

Evitez de déclencher manuellement des demandes de resynchronisation lancées par I'utilisateur
sur le WLC, sauf si cela est nécessaire pour le dépannage.

Domaines d'intervention communs

AP non visible dans PnP : vérifiez le chemin de détection AP, y compris DHCP Option 43 ou DNS.

Echec de la revendication AP : vérifiez les journaux du service d'intégration.

AP revendiqué mais non joint au WLC : vérifiez I'état de jonction du contrdleur et la raison de
I'échec de jonction.

Workflow PnP bloqué apres la revendication : si le point d'acces a rejoint le WLC mais n'est pas
visible dans l'inventaire, vérifiez le service d'inventaire, le traitement des interruptions et la file
d'attente de synchronisation.

Provisionnement déclenché mais configuration non appliquée comme prévu : vérifiez provisioning-
service et network-programmer.



Validation des résultats recommandée

Vérifiez que le point d'acces est correctement revendiqué dans PnP.

A partir de la page Catalyst Center PnP, vérifiez que le point d'accés n'est plus en état d'erreur et
que |'état de la demande est correct.

Vérifiez que I'état exécuté du workflow Plug-and-Play est visible pour le point d'acces.

Vérifiez que I'AP a rejoint le WLC.

show ap summary

show ap tag summary

show wireless stats ap join summary
show wlan summary

show wireless stats ap join summary

Vérifiez que le point d'acces est présent dans la liste des points d'acces joints et qu'il n'y a pas
d'échecs de jointure.

Vérifiez que le point d'acces est visible dans l'inventaire Catalyst Center.

Validez a partir de l'inventaire Catalyst Center que le point d'accés apparait sous le site attendu et
est dans I'état accessible.

Vérifiez que le workflow d'intégration ou de mise en service s'exécute correctement sans erreurs.

A partir de Catalyst Center, vérifiez que la tache d'intégration ou de mise en service s'exécute
correctement.



A propos de cette traduction
Cisco a traduit ce document en traduction automatisée vérifiée par une personne dans le

cadre d’un service mondial permettant a nos utilisateurs d’obtenir le contenu d’assistance
dans leur propre langue.

Il convient cependant de noter que méme la meilleure traduction automatisée ne sera pas
aussi précise que celle fournie par un traducteur professionnel.



